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はじめに 

 

Sentinel LDK（License Development Kit）は、アプリケーションのプロテクション、ライセンスの実装、アクティベーシ

ョンからレポート機能まで、ソフトウェアのライフサイクル全体を管理する統合環境を提供します。Sentinel LDKは、現

行の Sentinel HASP v5.1x の機能を拡張させた後継製品となります。 

 

本書は、初めて Sentinel LDK を手にされるお客様が、ツールキットのインストール、アプリケーションのプロテクトと

ライセンス実装といった基本機能を簡単に体験していただくためのものです。 Sentinel LDK では、多彩なプロテクショ

ン、および、ライセンシング機能をご用意しておりますが、初めてご利用になる方には、Envelope ツールと EMSを使用す

ることで、簡単にアプリケーションのライセンシングを実現することができます。本書のステップに沿って操作を行い、

Sentinel LDKの基本機能を習得してください。 

  

本書の内容について、「ステップ 1」では、Sentinel LDK のインストール手順を説明しています。「ステップ 2」では、評

価を始めるにあたって、理解しておくべき基本事項を説明しています。Sentinel LDK では、プロテクトさせたアプリケー

ションをアクティベートさせるプロテクションキーとして、ハードウェアキー（HLキー）と、ソフトウェアキー（SLキー）

の 2種類があり、どちらかを選択できるようになっています。「ステップ 3」では、HLキーを使用したプログラムのプロテ

クションとライセンシング手順を、「ステップ 4」では、SLキーを使用したプログラムのプロテクションとライセンシング

手順を説明しています。「ステップ 5」では、アクティベートした後にライセンスを更新する手順について説明しています。 

上記の基本ステップ以外でよく利用される機能については、「付録」にまとめました。必要に応じて活用してください。 

  

なお、Sentinel LDK では複数のプラットフォームをサポートしておりますが、本書は、Windows環境で Sentinel LDK を評

価するための基本操作のみが記載された入門書となります。Macおよび Linux版をご利用のユーザは、本書ステップ 2「Mac

版および Linux版について」を一読のうえ作業を進めてください。本書に説明されていない機能や詳細については、リリ

ースノートの「Sentinel LDK Documentation」記載の製品マニュアル もしくは ヘルプを参照してください。 

 

Sentinel LDK インストールフォルダ内（\\Program Files\SafeNet Sentinel\Sentinel LDK\Docs） 

 

本書は、英語版の製品マニュアル Quick Start Guide / Tutorial の内容を補完する日本語版スタートガイドとなります。 

 

Sentinel LDK に関する技術的なご質問は、以下のメールアドレスまでお問い合わせください。 

SafeNet テクニカルサポート：support@safenet-inc.com 

 

 

注： 

Sentinel LDK 7.0の評価においては、Sentinel LDK /Sentinel HASP /HASP SRM がインストールされていない環

境にインストールしてください。評価終了後、開発環境を移行させる場合は、「Installation Guide」Chapter 2 

“Upgrading Sentinel LDK From Earlier Versions”を参照してください。 
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ステップ 1：Sentinel LDK のインストール 

 

■ Sentinel LDK 7.0 の構成とインストール前提条件 

Sentinel LDK の開発環境は、プロテクションのための Sentinel LDK Vendor Suite、および、ライセンシングのための

Sentinel EMSから構成されます。さらに Sentinel EMSは、そのバックエンドに Microsoft SQL Serverおよび Apache Tomcat

を使用します（Sentinel LDK インストールパッケージに包含されています）。各コンポーネントは下図のように単一の

マシンにインストールしても、別々のマシンにインストールしても構いません。本書では、単一マシンへのインストー

ル方法について説明します。 

 

・ 単一マシンへのインストール  ・開発環境を分散したインストール 

 

 

 

 

 

 

 

 

 

 

詳細は、リリースノートの「Supported Platform for Sentinel LDK – End Users and Vendors」もしくは「Sentinel LDK 

– v.7.0 Installation Guide」Chapter 1 “Sentinel LDK Installation Prerequisites”をご参照ください。 

 

■ インストール時のトラブルシューティングについて 

「Sentinel LDK – v.7.0 Installation Guide」Chapter 4 “Troubleshooting for Sentinel EMS Installation” 

もしくは 

「Sentinel LDK トラブルシューティングガイド」（SRM 日本語ポータルサイト > トラブルシューティングに掲載） 

をご参照ください。不明点があればテクニカルサポートまでお問い合わせください。 

  

開発マシン 

EMS 

Vendor 

Suite 

SQL 

Server 

開発マシン 1 

Vendor 

Suite 

開発マシン 2 

サーバマシ

EMS Vendor 

Suite 

SQL 

Server 

 Tomcat  Tomcat 
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本項では、Sentinel LDK の Express インストールの手順について説明します。Sentinel LDK のインストーラには、サー

ドパーティ製品である Microsoft SQL Server Database および Apache Tomcat が含まれています。円滑にご評価いた

だくため、両ソフトがインストールされておらず、Sentinel HASP DK もインストールされていない、できる限りクリー

ンなマシンをご用意ください。 

  

 

1. Sentinel LDK メディアの \Windows\setup.exe をダブル

クリックします。ウェルカム画面の指示にしたがい、「Next」

をクリックします。 

 

 

 

 

 

 

 

 

 

2. License Agreement に同意する場合は、「I accept…」 に

チェックして「Next」をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

3. Installation Mode 画面にて、初期インストールの場合

は、「Sentinel EMS」 および 「Sentinel Vendor Suite」

両方がチェックされた状態で「Next」をクリックします。 
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4. セットアップタイプの選択画面が表示されま

す。ここでは、「Express」をクリックします。 

 

「Advanced」タイプを選択する場合は、

Installation Guide の Chapter 2  

“Installing Sentinel LDK for Windows”

を参照してください。 

 

 

 

 

 

 

 

 

5. Destination Folder 画面が表示されます。 

デフォルトのまま「Install」をクリックしま

す。 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. インストール開始画面が表示されます。 
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7. JRE と SQL Server EE 2008 R2 のインストール開

始画面が表示されます。「Install」をクリックし

ます。 

 

Windows セキュリティの警告が表示されることが

ありますが、その場合はアクセスを許可してくだ

さい。 

 

 

 

 

 

 

 

 

8. Sentinel EMS のインストール完了画面が表示さ

れます。「Finish」をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

9. Sentinel Vendor Suite の画面が表示されます。 
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10. 手順(3)で Sentinel EMS がチェックされている場合は、最後に EMS へのログイン確認のため、「EMS」をクリックし

てください。EMS のログイン画面が表示されたら準備は完了です。 
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ステップ 2：ご評価の前に 

 

本項では、Sentinel LDK を使用する際に理解しておくべき基本事項について説明します。不明な用語については、

「Sentinel LDK – v.7.0 Software Protection and Licensing Guide」巻末の Glossary（用語集）をご覧ください。 

 

1) 前提条件 

本製品は、ソフトウェアデベロッパが自社のアプリケーションを Sentinel LDK のプロテクションシステムに組み込

んで使用するため、読者対象はソフトウェア開発者を前提としています。プログラミングの知識のない方は、ソフ

トウェア開発経験者もしくは同等の知識を有する方と共同で作業してください。 

 

2) 評価に必要なもの 

・Sentinel LDK v.7.0 DVD または Windows ダウンロード版インストーラ 

・評価用（DEMOMA）HL プロテクションキー（HL キー利用の場合のみ） 

 

3) ライセンシング計画の重要性 

プログラムのプロテクトには、Envelope によるバイナリファイルのラッピングと、Licensing API によるソースコ

ードへのプロテクションコードの組み込みの 2 種類の方法があります。プロテクションキーへのライセンシングに

は、EMS による GUI ベースでの方法と、License Generation API による方法があります。本書の基本ステップでは、

Envelope によるプロテクションと、EMS によるライセンシングをベースに説明していきます。 

本書で Sentinel LDK の基本操作を習得する目的では、記載のシナリオのとおりに進めてください。実際に自社のプ

ログラムに対してプロテクトとライセンシングを適用する際は、「Sentinel LDK – v.7.0 Software Protection and 

Licensing Guide」 PART1 “GETTING STARTED”、 PART 2 “PROTECTION”、 3 “LICENSING” を参考にしてください。 

 

4) プログラムとライセンスの紐づけ 

プロテクトするプログラム側と、プロテクションキーのライセンス側は、「フィーチャ ID」という任意の数値デー

タによって紐づけられます。フィーチャ ID は、プログラム全体で一つにすることも、プログラムの機能毎に複数割

り当てることもできます。また、フィーチャ ID は「プロダクト」というまとまりで管理されます。開発担当者とラ

イセンス担当者の間で、ライセンス分けする単位と、プログラムのどの機能に何番を割り当てるかを事前に決めて

おいてください。 

 

例 1：プロダクト 1 つに対しフィーチャ ID を 1 つ割り当て 

 プロテクションキー側 

プロダクト名 キータイプ フィーチャ ID ライセンス条件 説明 

BounceLite HL 50 実行回数 2 回 BounceLite プロダクト全体で一

つのライセンス 

 プログラム側 対象プログラム：Win32_Bounce50.exe （フィーチャ ID 50 を指定） 

 

 

例 2：プロダクト 1 つに対しフィーチャ ID を複数割り当て 

 プロテクションキー側 

プロダクト名 キータイプ フィーチャ ID ライセンス条件 説明 

Design Office HL or SL 1 永久 ベーシック機能 

2 有効期間 30 日 アドバンス機能 

3 有効期間 1 年 印刷機能 

 プログラム側 対象プログラム：DesignOffice.exe （ベーシック機能に FID 1、アドバンス機能に FID 2…） 
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5) どのプロテクションキー/モードを使用するか？ 

同じバッチコードの同じフィーチャ ID を指定する限り、プロテクションキー/モードのどの組み合わせでもプロテ

クトしたプログラムを動作させることができます。暫定ライセンスは、SL/HL キーの各モード（AdminMode/UserMode）

と組み合わせて使う以外に、プロテクションキーに依存せずに単独で使用することもできます。下記のような幅広

い利用パターンで使えるため、評価を通してどのような利用方法がよいかご判断ください。 

 

使用パターン 利用例 本書の参照先 

HL キー（AdminMode）のみ HL キー(AdminMode)のみを利用 ステップ 3 

HL キー（UserMode）のみ HL キー(UserMode)のみを利用 ステップ 3 

HL キー(AdminMode）＋暫定ライセンス トライアル版として暫定 L を使用し、正規版は HL キーを利用。

または暫定 L をトラブル時の緊急対応用として利用 

ステップ 3,4 

HL キー(UserMode)＋暫定ライセンス トライアル版として暫定 L を使用し、正規版は HL キーを利用。

または暫定 L をトラブル時の緊急対応用として利用 

ステップ 3,4 

SL キー(AdminMode)＋暫定ライセンス トライアル版として暫定 L を使用し、正規版は SL キーを利用。

または暫定 L をトラブル時の緊急対応用として利用 

ステップ 4 

SL キー(UserMode)＋暫定ライセンス トライアル版として暫定 L を使用し、正規版は SL キーを利用。

または暫定 L をトラブル時の緊急対応用として利用 

ステップ 4 

SL キー(AdminMode)のみ SL キー(AdminMode)のみを利用 ステップ 4 

SL キー(UserMode)のみ SL キー(UserMode)のみを利用 ステップ 4 

暫定ライセンスのみ マーケティング用に暫定ライセンスを利用。またはリバースエ

ンジニアリング対策としてプロテクションのみ重視 

ステップ 4 

HL キー＋SL キー＋暫定ライセンス 上記全て ステップ 3,4 

   

  評価にかかる作業時間：トラブルなく本書の各項目を終了するまでにかかる時間の目安は次のとおりです。 

- HL キーのみ（ステップ 3） -> 30 分～1 時間 

- SL キーのみ（ステップ 4） -> 30 分～1 時間 

- 暫定ライセンスのみ（ステップ 4 の一部） -> 30 分 

各ユニットの基本的なステップは共通化されており、SL と HL、およびの AdminMode と UserMode の作業の違いはご

くわずかです。 

上記以外の各ユニットについても、それぞれ 30 分～1 時間程度を見積もってください。全ての項目を通しても 1

～2 日で習得できます。 
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6) 使用するバッチコード 

Sentinel LDK では、評価用バッチコード「DEMOMA」が標準でプリインストールされています。本書ではこの DEMOMA

を使用して説明しています。商用で使用するバッチコードは、本番用の Master キー購入時に（新規または既存の）

一意となる固有コードが割り当てられます。DEMOMA での評価が終了したら、Master キーを Sentinel LDK 開発環境

にインストールして、商用のベンダコード（*.hvc ファイルの中身の暗号化コード）と商用ライブラリを入手して

ください。手順については、「付録 6：Master キーのインストールと更新」を参照してください。 

 

DEMOMA バッチコードと商用バッチコードの違いについて 

 

Sentinel LDK 開発環境の各ツールの操作においては、GUI 上のバッチコードまたはベンダコードの指定箇所を変更

するだけで、目的のバッチコードで作業することができます。 

プロテクトするプログラム上においては、ベンダコードの変更と、商用ライブラリへの置き換えが必要です。置き

換えの詳細は、「付録 3：API によるプロテクション（Licensing API）」を参照してください。 

 

 評価用 商用 

バッチコード DEMOMA 例：[ABCDE]（5 桁英字） 

hvc ファイル DEMOMA.hvc 例：[ABCDE].hvc 

ライブラリファイルの例 hasp_windows_demo.dll hasp_windows_[12345].dll 

（バッチコードに紐付いた数字） 

 

また、DEMOMA バッチコードではすべての機能を無制限に利用できますが、商用バッチコードにおいては、特定機能

の利用については別途ライセンスの購入が必要です。詳細は、「付録 6：Master キーのインストールと更新」をご一

読ください。 

 

 

7) 主要ツールについて 

ほとんどのツールは Vendor Suite から起動することができます。Envelope および ToolBox については、オンライ

ンかオフラインか選択できます。オンラインでは、事前に EMS サーバ上に定義されたデータを参照しフィーチャ ID

を選択できます（Envelope/ToolBox の画面下にある”To connect to …here”をクリック）。オフラインでも手動

でフィーチャ ID を設定すれば同じ結果となりますので、本書ではデフォルトのオフラインで進めています。詳細に

ついては、各ツールのヘルプを参照してください。 

 

  ■Envelope 

EMS サーバへログインすることも、オフ

ラインで実行させることもできます（デ

フォルトはオフライン）。 

バッチコードは、プロジェクトペインの

Sentinel Vendor Code 欄で選択しま

す。”Add Programs”またはドラッグ＆

ドロップで対象プログラムを追加のう

え、プロテクトしてください。必要に応

じて任意のパラメタ調整が可能です。 
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Envelope のパラメタ調整について 

サポートするファイルタイプにより設定可能なパラメタは異なりますが、デフォルトの値でセキュリティ強度と実行時

パフォーマンスのバランスはとられています。このため、変更する必要がない場合はデフォルトの値を推奨します。特

別な要件がある場合は、ヘルプを参照しながらパラメタを調整してください。 

 

ここでは、主要なパラメタのみ説明します 

 

・ Periodic background checks : (全ファイルタイプ >Protection Settings タブ）プロテクションキーをチ

ェックする間隔を秒数で指定。デフォルトでは無効、有効にした場合のデフォルト値は 300 秒。  

・ LOCKING_TYPE : (全ファイルタイプ >Protection Settings タブ）プロテクトアプリが動作するプロテク

ションキータイプを指定。デフォルト値=HL or SL AdminMode。 

・ Enable Custom Protection Key Login Scope ： (全ファイルタイプ >Protection Settings タブ）ログイン時の

条件を XML 形式で指定（hasp_login_scope に相当）。デフォルトでは無効。 

・ AppOnChip ：(Win32 アプリのみ >AppOnChip タブ）LDK7.0 から追加された HL キー向けのセキュリティ強化機

能。デフォルトでは無効。 

 

Envelope によるプロテクションがうまくいかない場合の対処 

プロテクション時にエラーとなったり、プロテクション後の実行時にエラーとなることは十分起こりうることです。

「Sentienl LDK トラブルシューティングガイド」を参考に対処してください。 
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  ■ToolBox 

EMS サーバへログインすることも、オ

フラインで実行させることもできま

す（デフォルトはオフライン）。API

パネル欄から、使用する API のカテゴ

リを選んでクリックすると、選んだ

API がアクティブになります。プログ

ラミング言語は、File > Settings > 

Toolbox > Programming Language で

選択できます。シュミレーションした

APIの実装コードが生成コードペイン

欄に表示されるので、コピー&ペース

トして利用できます。バッチコードは、

Licensing API の場合、hasp_login()

画面の VendorCode で指定します。 

 

 

  ■EMS 

起動時に EMS サーバへログインし

ます（デフォルト User ID /Password

は、admin/admin）。ファンクション

バーから目的の操作を選んでくだ

さい。バッチコードは各画面の

Batch Code リストから選択します。 

初期登録時の流れは、Catalog タブ

の Features/Products でライセン

スを定義し、Entitlements タブで

目的のプロテクションキー（HL/SL）

を生成します。 

 

 

 ■RTE 

RTE（Run-time）は Sentinel LDK の Vendor Suite、EMS に並ぶコンポーネントの一つであり、LDK のインストー

ルに伴って自動的にインストールされます。ここではコマンドラインでの基本的な操作方法を記しておきます。 

 

\\Program Files\SafeNet Sentinel\Sentinel LDK\Redistribute\Runtime Environment\cmd Install\haspdinst.exe 

・インストール： >haspdinst.exe -i 

・アンインストール： >haspdinst.exe –purge 

（「-purge」は強制アンインストール用スイッチのため、検証目的以外での常用はしないでください）  

・ヘルプ：  >haspdinst.exe -h  

 

インストール/アンインストールの確認は、次頁の ACC にアクセスしてください。ACC が表示されればインストー

ル済み、表示されなければアンインストール（または Sentinel local License Manager サービス停止）状態です。 

RTE のインストール方法は、上記以外に GUI インストーラ（HASPUserSetup.exe）、インストール API 等があります。

詳細は「Sentinel LDK – v.7.0 Software Protection and Licensing Guide」」Chapter 14 “Distributing Sentinel LDK 

with Your Software”を参照してください。 
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  ■Admin Control Center (ACC) 

ACC は RTE の機能の一部であり、RTE がインストールされた環境で利用できる Web ブラウザベースのコンソールツ

ールです。ライセンスの確認からネットワークライセンスの制御等、多様な用途で使用できます。Sentinel LDK 開

発環境においては、Vendor Suite > Additional Tools > Admin Control Center をクリックして起動できます。

エンドユーザ環境においては、http://localhost:1947 にアクセスして起動します。使用するバッチコードに関わ

らず、アクセス可能なすべての HL キー/SL キー（SL/HL UserMode は除く）が表示されます。 

 

 

 

 

 

 

 

 

詳細は、ACC のヘルプを参照してください。 

 

  ■Remote Update System (RUS) 

RUS ユーティリティは、ライセンスの更新や SL キーの移動時

に使用するユーティリティであり、単体で配布することができ

ます。デフォルトの RUS は、DEMOMA バッチコード用であり、

Vendor Suite > Additional Tools > Sentinel RUS をクリッ

クする、もしくは 以下のフォルダに格納された実行ファイル

をクリックして起動します。 

 

\\Program Files\SafeNet Sentinel\Sentinel 

LDK\VendorTools\VendorSuite\rus.exe 

 

使用するバッチコード専用に、EMS > Developer > RUS Branding 

で画面の表示をカスタマイズ（ブランディング）することがで

きます。商用利用の際は、ブランディングされた RUS を使用し

てください。詳細は EMS のヘルプを参照してください。 

 

 

■Master Wizard 

Sentinel LDK 開発環境に、正規購入された Master キーを使っ

て商用バッチコードを導入する際に使います。Master キーを

マシンに接続し、Vendor Suite > Additional Tools > Sentinel 

Master Wizard をクリックしてください。EMS へのログインの

後、デフォルトの”Download my customized APIs…”を指定

し、ウィザードの指示にしたがって処理を完了させてください。

インターネット接続により、生成するライブラリを外部からダ

ウンロードするため、1 時間程度かかります。 

詳細は「付録 6：Master キーのインストールと更新」を参照し

てください。 

 

  

http://localhost:1947/
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8) ライセンスの設定 

Sentinel LDK では、プロテクションキーが HL か SL かに関わらず、ライセンスは EMS の ライセンス条件設定画面

で行われます（EMS > Catalog > Products）。通常はプロダクト定義時に行いますが、後で設定したい場合は、エン

タイトルメント時に行うこともできます（ライセンスタイプで Specify at entitlement time を選択）。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

DEMOMA であれば、SL キーの場合はすべてのライセンスを試すことができます。HL キーの場合は、対応するキータ

イプが必要です。（例：Time/NetTime キー以外のモデルで、有効期限/有効期間ライセンスの書込みは不可） 

ライセンス設定の詳細は、EMS のヘルプを参照してください。 

 

暫定ライセンスの設定は、次の画面で行います（EMS > Catalog > Products > Provisional）。 
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9) Sentinel LDK システムのメンテナンス 

すべてのプログラム > SafeNet Sentinel > Sentinel LDK > Check for Updates をクリックして、Sentinel LDK 

Software Manager を起動すると、更新可能な Sentinel ソフトウェアが表示されます。このツールを利用して、定

期的にソフトウェアを更新することをお勧めします。また、不測の事態に備え、Sentinel EMS のデータ（SQL Server 

DB）は定期的にバックアップするようにしてください。（バックアップの詳細は、「Sentinel LDK トラブルシューテ

ィング FAQ」を参照のこと） 
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10) HASP HL キーと Sentinel HL キー 

Sentinel LDK v7.0 では、従来型の HASP HL キーと、次期 Sentinel HL キーの両世代のキーを利用できます。 

Sentinel HL キーは HASP HL キーの上位モデルであり、従来の機能に加えて、ドライバレス（HL-User Mode）と

して利用できる機能、および、Sentinel SuperPro キーとの互換機能が加わりました。 

それぞれのキーの詳細については、Sentinel HL データシート（Sentinel HL Data Sheet.pdf）、および HASP HL

のデータシート（Sentinel HASP DK に同梱の Sentinel HASP HL.pdf）を参照してください。 

 

外観（例） 外観の特徴 リリース状況 

HASP HL キー 

 

例：Max モデル 

・外装に”HASP HL”の彫り込み 

・キャップなし 

・色はモデルにより異なる 

評価用/商用とも利用可能 

Sentinel HL キー 

 

 

例：Pro モデル 

・外装に”Sentinel”の彫り込み 

・キャップあり 

・楕円形の紐通しの穴あり 

・色はモデルにより異なる  

評価/商用とも利用可能。 

HASP HL キーをご利用中で、新たに

Sentinel HL キーのドライバレスモ

ードの評価を希望する場合は、弊社

営業までお問い合わせください。 

 

 

 

11) Mac 版および Linux 版について 

Sentinel LDK 7.0 のダウンロード版 には、Mac 版は含まれません。 

Linux のプロテクションキーへのライセンシングは、Windows プラットフォーム上の EMS を使用して行います。  

アプリケーションへのプロテクトは、Linux マシン上の開発環境で行います。 

したがって、プロテクション以外の作業については、本書を参照してライセンシングを行ってください。 

全体の流れについては、インストールメディア内の次のファイルを参照してください。 

・Sentinel LDK for Linux_Getting Started.html（Linux フォルダ内） 

これ以外の詳細については各種製品マニュアルをご参照ください。 
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ステップ 3：HL キーを使用したプロテクション＆ライセンシング 

 

本項では、アプリケーションを HL キーでロッキングする一般的な方法を説明します。HL キーの場合、物理的な HL キー

のモデルによって使用できる機能が異なります。詳細は HL キーのデータシートをご参照ください。 

また、HL キーには、RTE が必要な AdminMode と、LDK v6.4 から加わった RTE を必要としない UserMode があります。本

項の内容は以下のとおりです。 

 

■ 3-1 HL キーの一般的な利用手順 

■ 3-2 HL Basic モデルを利用する場合 

■ 3-3 HL UserMode（ドライバレス）を利用する場合  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



 

 

 

 

 

 

17 

 

3-1. HL キーの一般的な利用手順 

 

本項では、アプリケーションを HL キーで RTE が必要な Admin Mode としてロッキングする方法を説明します。 

 

●シナリオ 

実行回数制限付きの BounceLite プロダクトを、HL キーでロックして出荷します。 

 

プロテクションキー側 

プロダクト名 キータイプ フィーチャ ID ライセンス条件 説明 

BounceLite HL 50 実行回数 2 回  

 

プログラム側 

対象プログラム：Win32_Bounce50.exe （フィーチャ ID 50 指定 / Envelope を使用） 

 

●全体の作業項目とポイント 

作業項目 主なポイント 実施者 使用するツール 

1.プログラムのプロテクト -Sentinel Vendor Code: DEMOMA 

-対象プログラム指定:   Bounce50.exe 

-フィーチャ ID:        50 

ソフトウェアベンダ 

（開発担当者） 

Envelope（または 

Licensing API） 

2.フィーチャの定義 -Batch Code:           DEMOMA 

-フィーチャ ID:        50 

ソフトウェアベンダ EMS > Catalog > 

Features 

(EMS アカウント： 

admin/admin) 

3.プロダクトの定義 -Batch Code:           DEMOMA 

⇒New Product 

-プロダクト名:         BounceLite 

-ロッキングタイプ:     HL or SL 

-含めるフィーチャ ID:  50 

-フィーチャ毎のライセンス定義 

  ライセンスタイプ:  Execution Count 2 

 コンカレンシ（オプション：ネットワークラ

イセンスの場合） 

  アクセシビリティ(オプション：RDT 経由/VM

環境での動作可否)  

-ユーザメモリの定義（オプション） 

-“Upgrade to Driverless”:指定なし 

 (オプション:Driverless構成キーへのアップ

グレードが必要な場合のみ) 

ソフトウェアベンダ EMS > Catalog > 

Products 

4.エンタイトルメント 

（HL キーへの焼き付け） 

-Batch Code:           DEMOMA 

-カスタマ指定（オプション） 

-プロダクトの追加:     BounceLite 

-エンタイトルメントタイプ: Hardware Key 

ソフトウェアベンダ EMS > Entitlements > 

Entitlements  

 

5.エンドユーザ体験 -RTE のインストール（AdminMode の場合） 

-HL キー（DEMOMA）の接続 

-プログラムの起動 

エンドユーザ （ACC） 
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⇒ 操作方法の詳細については、動画ファイル「LDK7.0_HL_Demo.avi」をご覧ください。 

 

●配布物 

HL キーでプロテクトしたプログラムを動作させるために必要な配布物は次のとおりです 

プロテクションキータイプ 必要な配布物 備考 

HL キー -プロテクトしたプログラム（Bounce50.exe） 

-プロテクションキー（HL キー） 

-RTE（AdminMode の場合のみ） 

左記以外に、ライセンスのリモート更新

を行う場合は RUS ユーティリティも必

要（詳細はステップ 6 参照） 

 

Sentinel LDK がインストールされた開発環境で、この後のエンドユーザ体験を実施する場合、RTE は既にインスト

ールされているため、改めて RTE のインストールは不要です。Sentinel LDK 開発環境以外のマシンで実施する場合

は、RTE を配布してインストールしてください。（ステップ 2 > 主要ツールについて > RTE を参照） 

 

ソフトウェアと RTE の配布についての詳細は、「Sentinel LDK – v.7.0 Software Protection and Licensing Guide」Chapter 

14 “Distributing Sentinel LDK with Your Software”をご参照ください。 

 

●HL キーのエンドユーザ体験 

上記必要な配布物をエンドユーザに配布し、HL キーをマシンに接続してプロテクトしたアプリケーションを実行し

てください。ライセンスの状況は ACC で確認できます（AdminMode の場合のみ） 
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3-2. HL Basic モデルを利用する場合 

 

HL Basic キーは起動制御のみに特化した簡易機能版モデルです。Basic キーへの書き込みは不要ですが、下記の制

約がありますのでご注意ください。 

1) プロテクトできるライセンス数は 1 種類のみです。（Feature ID 0 番のみ） 

2) スタンドアロン環境での起動制御以外、メモリー/ライセンス更新などの拡張機能はサポートされません。 

3) フィーチャ ID 0 番は、Basic キー用もしくは他のモデルでは検証用の扱いです。他のキータイプ/モデルにお

いて、商用での 0 番のご利用はなるべくお控えくだい。 

 

●手順 

作業項目 主なポイント 実施者 使用するツール 

1.プログラムのプロテクト -Sentinel Vendor Code: xxxxx 

-対象プログラム指定:   Bounce0.exe 

-フィーチャ ID:        0 

ソフトウェアベンダ 

（開発担当者） 

Envelope（または 

Licensing API） 

2.エンドユーザ体験 -RTE のインストール 

-HLBasic キー（xxxxx）の接続 

-プログラムの起動 

エンドユーザ （ACC） 
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3-3. HL UserMode（ドライバレス）を利用する場合  

 

HL UserMode（ドライバレス）は、エンドユーザ環境で RTE をインストールすることなくプロテクションキーによる認証

を実現できます。この機能は Sentinel HL のドライバレス構成のキーを使用します。Sentinel HL キーの購入時にドラ

イバレス構成として注文いただくか、もしくは Sentinel HL キーの HASP 構成のキーをドライバレス構成にアップデート

してお使いください。 

 

●手順 

基本的に 4-1 の手順と同じですが、次のロッキングタイプの指定に注意してください： 

・プロダクト定義時（EMS）のロッキングタイプ → HL、HL or SL-AdminMode または HL or SL(AdminMode or UserMode) 

・Envelope のロッキングタイプ → Protection Details > Advanced > LOCKING_TYPE に HL、HL or SL-AdminMode  

       または HL or SL(AdminMode or UserMode)  

エンドユーザ体験での RTE のインストールは不要です。HASP 構成の HL キーからドライバレス構成にアップデートする

場合は、プロダクト定義時に”Upgrade to Driverless”にチェックして更新してください。一旦ドライバレス構成に更

新すると HASP 構成には戻せません。既にドライバレス構成のキーに対する操作時は、”Upgrade to Driverless”にチ

ェックする必要はありません。 

 

注： 

UserMode では、AdminMode と異なり次の機能をサポートしていません。 

1) Admin Control Center が使用できません。ライセンスの確認は、別途 Licensing API の hasp_get_info() 

等で情報取得して実施してください。  

2) データの暗号化（DataEncryption）機能を利用できません。 

3) HL Net キーでネットワークライセンスを使用する場合は、UserMode でも RTE が必要となります。 
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ステップ 4：SL キーを使用したプロテクション＆ライセンシング 

 

本項では、アプリケーションを SL キーでロッキングする一般的な方法を説明します。SL キーには、RTE が必要な

AdminMode と RTE を必要としない UserMode があります。また、SL アクティベーションに先立って暫定ライセンスとして

動作させるパターンとさせないパターンがあります。 

 

 

■ 4-1 SL キーの一般的な利用手順 

■ 4-2 暫定ライセンスを単独で利用する場合 

■ 4-3 SL UserMode を利用する場合  
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4-1. SL キーの一般的な利用手順 

 

●シナリオ 

有効期限付きの暫定プロダクト、および永久ライセンス付きの正規プロダクトを、SL キーの AdminMode でロックして出

荷します。 

 

プロテクションキー側 

プロダクト名 キータイプ フィーチャ ID ライセンス条件 説明 

BounceTrial Provisional 10 60 日 BounceFull のトライアル版 

BounceFull SL AdminMode 10 永久  

 

プログラム側 

対象プログラム：Win32_Bounce10.exe （フィーチャ ID 10 指定 / Envelope を使用） 

 

●全体の作業項目とポイント 

作業項目 主なポイント 実施者 使用するツール 

1.プログラムのプロテクト -Sentinel Vendor Code: DEMOMA 

-対象プログラム指定:   Bounce10.exe 

-フィーチャ ID:        10 

ソフトウェアベンダ 

（開発担当者） 

Envelope（または 

Licensing API） 

2.フィーチャの定義 -Batch Code:           DEMOMA 

-フィーチャ ID:        10 

ソフトウェアベンダ EMS > Catalog > 

Features 

(EMS アカウント： 

admin/admin) 

3.プロダクトの定義 -Batch Code:           DEMOMA 

⇒New Product 

-プロダクト名:         BounceFull 

-ロッキングタイプ:     HL or SL 

-含めるフィーチャ ID:  10 

-フィーチャ毎のライセンス定義 

  ライセンスタイプ:  Perpetual 

 コンカレンシ（オプション：ネットワークラ

イセンスの場合） 

  アクセシビリティ(オプション：RDT 経由/VM

環境での動作可否)  

-ユーザメモリの定義（オプション） 

ソフトウェアベンダ EMS > Catalog > 

Products 

4.暫定プロダクトの定義 -Batch Code:           DEMOMA 

⇒BounceFull を選択> Actions > Provisional 

-暫定プロダクト名:    BounceTrial 

-ロッキングタイプ:     SL 

-含めるフィーチャ ID:  10 

-フィーチャ毎のライセンス定義 

  ライセンスタイプ:   

    Provisional  (Time_Period) : 60 days 

 コンカレンシ（オプション：ネットワークラ

イセンスの場合） 

  アクセシビリティ(オプション：RDT 経由/VM

ソフトウェアベンダ EMS > Catalog > 

Products 
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環境での動作可否)  

-ユーザメモリの定義（オプション） 

5.暫定プロダクトの準備 -Batch Code:           DEMOMA 

-暫定プロダクトの追加:  BounceTrial 

-V2C ファイルの生成 

-RTE ( haspdinst.exe ) の生成（オプション） 

ソフトウェアベンダ EMS > Developer > 

Bundle Provisional 

 

EMS > Developer >  

RTE Installer 

6.エンドユーザ体験 

（暫定ライセンス） 

-暫定付 RTEのインストール（AdminModeの場合） 

 または V2C ファイルの適用 

-プログラムの起動 

エンドユーザ ACC or RUS 

7.エンタイトルメント 

（プロダクトキーの生成） 

-Batch Code:           DEMOMA 

-カスタマ指定（オプション） 

-プロダクトの追加:     BounceFull 

-エンタイトルメントタイプ: Product Key 

 ユーザ登録指定（オプション:カスタマ指定 

 無い場合） 

ソフトウェアベンダ EMS > Entitlements > 

Entitlements  

 

8.エンドユーザ体験 

（正規ライセンス） 

-SL キーのアクティベーション 

-ユーザ登録（7.の指定による） 

-プログラムの起動 

エンドユーザ EMS > Customer Portal 

または 

ACC or RUS 

 

暫定ライセンスを使用しない場合は、手順 4～6 を省略してください。Sentinel HASP の SL キーと異なり、Sentinel LDK

の SL キーにおいて、暫定ライセンスは必須ではありません。 

 

⇒ 操作方法の詳細については、動画ファイル「LDK7.0_SL_Demo.avi」をご覧ください。 
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●配布物について 

SL キーの AdminMode でプロテクトしたプログラムを動作させるには、プログラムを実行するマシンに RTE をインス

トールしなければなりません。アクティベーション方法によって必要な下記を配布します。 

 

プロテクションキータイプ 必要な配布物 備考 

SL キー -プロテクトしたプログラム（Bounce10.exe） 

-SL プロダクトキー 

暫定ライセンスを使用する場合： 

 -暫定ライセンス付き RTE（AdminMode の場合） 

 -暫定ライセンス V2C（UserMode の場合） 

アクティベーション方法： 

 オンラインアクティベーションの場合： 

-EMS カスタマーポータル URL 

 オフラインアクティベーションの場合： 

-RUS 

・プログラムと暫定ライセンス付き RTE

は、暫定ライセンスのエンドユーザ体験

で配布済であれば、再配布する必要はあ

りません。 

・RUS は、オフラインアクティベーショ

ンの場合以外でも、リモート更新や SL

のリホストで使用します。必要に応じて

配布してください。 

 

なお、Sentinel LDK がインストールされた開発環境で、この後のエンドユーザ体験を実施する場合は、RTE は既に

インストールされているため、標準版の RTE のインストールは不要です。Sentinel LDK 開発環境以外のマシンで実

施する場合は、暫定ライセンス付き RTE を配布してインストールしてください。 

 

ソフトウェアと RTE の配布についての詳細は、「Sentinel LDK – v.7.0 Software Protection and Licensing Guide」Chapter 

14 “Distributing Sentinel LDK with Your Software”をご参照ください。 

 

 

Note：  

標準版 RTE に暫定ライセンスの v2c を含めたものが暫定ライセンス付き RTE となります。以下のフォルダに配

置された標準版 RTE（haspdinst.exe）のバージョンがベースとなるため、上位バージョンの RTE を使用して暫

定ライセンス付き RTE を生成したい場合は、同フォルダの haspdinst.exe を上書きしてから、暫定ライセンス

付き RTE を生成してください。 

格納場所： 

\\Program Files\SafeNet Sentinel\Sentinel LDK\Redistribute\Runtime Environment\cmd 

Install\haspdinst.exe 
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●SL キーのエンドユーザ体験 

正規版ライセンスとして SL のアクティベーションを行います。暫定ライセンスの有効期間が残っているいない、

また、暫定ライセンスの使用の有無に関わらず、SL のアクティベーションは随時可能です。 

 

■ A オンラインでのアクティベーション 

■ B オフラインでのアクティベーション 

■ C アクティベーション状況の確認（オプション） 

 

正規ライセンス版の実行  

SL キーのアクティベーションでは、オンラインで行う方法と、オフラインで行う 2 つの方法があります。オンラ

インでアクティベーションを行う場合は、インターネット接続が前提です。インターネットに接続されていない環

境では、オフラインでのアクティベーションを実施してください。また、オフラインはエンドユーザがオフライン

状態の場合以外に、インターネット接続可能なオンライン状態でも実施できます。オンライン状態のエンドユーザ

が、何らかの理由でオンラインの手法で完了できなかった場合は、エンドユーザ自身が、ベンダとエンドユーザの

ロール（役割）の両方を実行してオフラインの手法で実施してみてください。 

 

■ A オンラインでのアクティベーション 

インターネット接続が可能なエンドユーザマシンで実施します。EMS のカスタマポータルサイト経由で行うパター

ンと、アクティベーション専用プログラム経由で行うパターンがあります。本シナリオでは EMS 環境とエンドユー

ザ環境が共存している、スタンドアロンでの実施を前提にしています。操作の詳細は動画ファイルをご覧ください。 

 

 

注： 

SL キーのオンラインでのアクティベーションでは EMS のカスタマーポータル画面を経由して実施されますが、

クライアントマシンに JRE がインストールされ、オンラインアクティベーション用の DLL 2 つが必要となり

ます。必要な JRE が無い場合はオンラインアクティベーション時に自動的に JRE ダウンロードサイトが開かれ

インストールを促されます。また、その後、オンラインアクティベーション用の 2 つの dll が EMS から自動ダ

ウンロードされようされますが、OS の権限および EMS が動作するブラウザの設定によっては必要な場所に自動

的に格納できません。その場合は、一旦、マイドキュメントなどに 2 つの DLL を格納した後で本来の場所、

｢C:\Program Files\Java\jre バージョン\bin｣の下に手動で移動させる必要があります。 

 

 

 

■ B オフラインでのアクティベーション 

 ここでは、インターネット接続できないエンドユーザがオフラインで実施する手順を記します。オフラインでア

クティベーションを行うこの説明では、エンドユーザのロール（役割）と、ソフトウェアベンダのロールが交互に
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出てきます。エンドユーザ環境には RUS ユーティリティが配布されていることが前提です。操作の詳細は動画ファ

イルをご覧ください。 

   

■ C アクティベーション状況の確認（オプション） 

 エンドユーザまたはベンダが、特定の Product Key からアクティベーション状態を確認する方法があります。詳

細は「Sentinel LDK v6.4 Quick Start Guide」の同じ項目を参照してください。 
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4-2. 暫定ライセンスを単独で利用する場合  

 

前述のステップ 4-1 では、SL アクティベーションを行う前の暫定的なライセンスとして紹介しましたが、暫定ライセン

スを、SL キーを使用せず暫定ライセンスのみとして利用したり、HL キーと組み合わせて利用することも可能です。 

 

●手順 

4-1 の～6.エンドユーザ体験（暫定ライセンス）までの手順と同じです。HL も SL も使用せず暫定ライセンス単独で使用

する場合も、暫定ライセンス用にベースプロダクト（4-1 の場合は BounceFull）を定義する必要があります。HL と組み

合わせる場合（例えば、HL キーユーザ向け故障時対応として）は、4-1 の BounceFull に相当するプロダクトのロッキン

グタイプを、HL キーに紐付けて定義してください。 

 

 

注： 

暫定ライセンスは、SL キーと異なり、マシンの指紋（フィンガープリント）を採取してノードロックはしませ

ん。次の点に留意してください。 

1) 暫定ライセンス付きの RTE、もしくは暫定ライセンスの V2C ファイルは、ファイルをコピーすればどのマ

シンでも動作させることができます。 

2) 一度インストールした暫定ライセンスの削除はできません。 

3) ライセンスの更新は、再生成した暫定ライセンスファイルの再適用で行います。 

 

 

 

Note： 

暫定ライセンスのライセンスタイプには、有効期限（1～90 日）と永久の 2 種類があります。本シナリオでは

有効期限のパターンで説明していますが、例えば、ノードロックせずどのマシンでも動作を許可したい、ただ

しリバースエンジニアリング対策だけは施したいという場合は、Envelope したアプリケーションに永久指定し

た暫定ライセンスを付与すると実現できます。 

なお、商用利用する場合は、別途専用のライセンスを購入する必要があります。詳細については「付録 6：Master

キーのインストールと更新」を参照してください。 
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4-3. SL UserMode（ドライバレス）を利用する場合  

 

SL UserMode（ドライバレス）は、Sentinel HL のドライバレス構成のキーと同じく、エンドユーザ環境で RTE をインス

トールすることなくプロテクションキーによる認証を実現できます。 

 

●手順 

基本的に 4-1 の手順と同じですが、次のロッキングタイプの指定に注意してください： 

・プロダクト定義時（EMS）のロッキングタイプ → SL-UserMode または HL or SL(AdminMode or UserMode) 

・Envelope のロッキングタイプ → Protection Details > Advanced > LOCKING_TYPE に SL-UserMode または  

        HL or SL(AdminMode or UserMode)  

エンドユーザ体験での RTE のインストールは不要です。 

 

注： 

UserMode では、AdminMode と異なり次の機能をサポートしていません。 

1) Admin Control Center が使用できません。ライセンスの確認は、別途 Licensing API の hasp_get_info() 

等で情報取得して実施してください。  

2) データの暗号化（DataEncryption）機能を利用できません。 

3) SL キーでネットワークライセンスを使用する場合は、UserMode でも RTE が必要となります。 
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ステップ 5：ライセンスの更新 

 

本項では、アプリケーションのライセンスを更新する一般的な方法、および HL キーを初期化する方法を説明します。  

ライセンスの更新は、プロテクションキータイプが HL か SL かに関わらず手順は同じです。 

 

■ 5-1. ライセンスの更新 

■ 5-2. HL キーの初期化 
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5-1. ライセンスの更新 

 

●シナリオ 

実行回数制限を超過し、ステップ 3 でライセンスが無効となった BounceLite プロダクトのユーザが、永久ライセンス付

きの BouncePro プロダクトにアップデートします。 

 

プロテクションキー側 

プロダクト名 キータイプ フィーチャ ID ライセンス条件 説明 

BouncePro HL 50 永久 BounceLite のアップグレード版 

 

プログラム側 

対象プログラム：Win32_Bounce50.exe （フィーチャ ID 50 指定 / Envelope を使用） 

 

●全体の作業項目とポイント 

作業項目 主なポイント 実施者 使用するツール 

1.プログラムのプロテクト 本シナリオでは不要（プログラム改修要の場合）   

2.フィーチャの定義 本シナリオでは不要（追加フィーチャ要の場合）   

3.更新用プロダクトの定義 -Batch Code:           DEMOMA 

⇒BounceFull を選択> Actions > Copy 

-暫定プロダクト名:    BouncePro 

-ロッキングタイプ:     HL or SL 

-含めるフィーチャ ID:  50 

-フィーチャ毎のライセンス定義 

  ライセンスタイプ:  Perpetual 

 コンカレンシ（オプション：ネットワークラ

イセンスの場合） 

  アクセシビリティ(オプション：RDT 経由/VM

環境での動作可否)  

-ユーザメモリの定義（オプション） 

ソフトウェアベンダ EMS > Catalog > 

Products 

(EMS アカウント： 

admin/admin) 

4.エンタイトルメント 

（更新用 V2C の生成） 

-Batch Code:           DEMOMA 

-カスタマ指定（オプション） 

-プロダクトの追加:     BouncePro 

-エンタイトルメントタイプ:  

 Protection Key Update 

 4つのオプションのいずれかで更新元キー特定 

 Customer / Product Key / C2V File / Key ID 

ソフトウェアベンダ EMS > Entitlements > 

Entitlements  

 

5.エンドユーザ体験 -更新用 V2C ファイルの適用 

-プログラムの起動 

エンドユーザ ACC or RUS 

 

⇒ 操作方法の詳細については、動画ファイル「LDK7.0_Update_Demo.avi」をご覧ください。 
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●配布物の確認 

今回のシナリオではプログラムの更新はなく、ライセンスの更新だけでした。この場合はライセンスファイルのみ

を配布します。 

 

プロテクションキータイプ 必要な配布物 備考 

アップデート -更新ライセンスの V2C 

-RUS 

プログラムの更新をともなう場合は、プ

ログラムも再配布してください。 

 

 

●エンドユーザ体験（更新ライセンスの適用） 

ライセンスファイル（V2C）を GUI ベースで適用する方法は、次の 2 通りあります： 

A. RUS ユーティリティ > Apply License File タブ > V2C ファイルを指定して「Apply Update」をクリック  

B. ACC > Update/Attach メニュー > V2C ファイルを指定して「Apply File」をクリック 

UserMode の場合は ACC を利用できないため、RUS ユーティリティを使用します。AdminMode の場合はどちらか使い

やすい方法を選択してください。 

EMS サーバとの同期（オプション）については、「Sentinel LDK v6.4 Quick Start Guide」の同じ項目を参照して

ください。 

 

 

5-2. HL キーの初期化 

 

HL キーの再利用のために中身を初期化するには、次の手順で行います。 

(1) 対象の HL キーを EMS インストールマシンに接続します。複数本同時も可能です。 

(2) EMS にログインし、Entitlements > Recycle をクリックします。 

(3) Recycle Keys 画面が表示され、対象 HL キーが一覧表示されます。 

(4) 対象キーにチェックしたうえで「Recycle」ボタンをクリックします。 

(5) 初期化成功メッセージが表示されれば完了です。 
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付録： 

 

下記付録の内容は、LDK6.4 ベースでの説明となります。「Sentinel LDK v6.4 Quick Start Guide」の各項目をご参照く

ださい。非互換がある場合は、サポートまでお問い合わせください。 

 

SRM カスタマーポータル http://support.safenet-inc.jp/srm/ 

→ 日本語マニュアル > マニュアル  Sentinel LDK v6.4 Quick Start Guide   2013 年 5 月 

 

付録 1：ネットワークライセンスの利用 

 

付録 2：SL ライセンスのリホスト（移動） 

 

付録 3：API によるプロテクション（Licensing API） 

 

付録 4：ライセンス生成 API（License Generation API） 

 

付録 5：管理 API（Admin API） 

 

付録 6：Master キーのインストールと更新 

 

付録 7：EMS Web サービス 

 

付録 8：レポーティング 

 

付録 9：データの暗号化 

 

  

http://support.safenet-inc.jp/srm/
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